Extended Structural Workflow Integration between Plant-Revit-Robot and Advance Steel

Marc Breugelmans - TDDatech - Benelux

Learning Objectives

- Learning objective 1
- Produce early stage structural models in Plant3D
- Learning objective 2
- Optimize and elaborate the structural model in different environments
- Learning objective 3
- Explore the extended interoperability between different Autodesk solutions
- Learning objective 4
- Discover the possibilities of the different Autodesk solutions

Description

In this class we will explore an extended structural steel workflow between different Autodesk solutions. Create, exchange and optimize a steel structure using the power of different Autodesk solutions in an integrated workflow. Design your steel structure and optimize it without the need to recreate it and using the unique capabilities of the suite workflows. In this demo we will cover the interoperability between the solutions starting to create an early stage steel structure in Plant 3D and import the structure into Revit Structure. Exchange these structure to Robot Structural Analysis for steel optimization. Update the structure, drawings and results in Revit Structure. Export the optimized steel structure to Autodesk Advance Steel for Structural Detailing and the creation of shop drawings. Navisworks or BIM360Glue will be used to review the project and perform clash detection. Afterwards we will reference the detailed structure back into Plant 3D to complete the workflow.

Your AU Experts

Marc Breugelmans received his master’s in architecture in 1995 from the Royal Academy of Fine Arts (Antwerp) and is now an engineering, and construction technical specialist at TDDatech-Benelux for the structural solutions in the Building Design Suite software. Over the years he has gained experience in the construction industry using several Autodesk Inc. Solutions. He started in 2007 with the Revit Structure software and was responsible for the Building Information Modeling (BIM) integration in a construction group. He also gained a lot of experience in using Revit software as a BIM solution where interoperability and exchange of information was a key feature. Since 2010 he’s responsible for Revit Structure software and other engineering applications at TDDatech. Besides Revit software, Robot Structural Analysis software, and AutoCAD Structural Detailing software, Marc also supports the workflows between the different Autodesk suites. With Revit software being present in different suites, his job isn’t limited to
Building Design Suite software. In addition, structural workflows with, for example, the Plant Design Suite or Infrastructure Design Suite, are part of his work.
1. **Produce early stage structural models in Plant3D**

Starting point is the design of the base platform of the steel structure this will be the first phase in the project.

**Step 1: Creation of a steel structure**

- In Plant 3D open Project: XXXX:\Dataset\Plant_3D\MBS-Steel-Silo-Structure
- In the Project Manager select Plant 3D Drawings and use the Copy Drawing to Project command

- Select the 3D_DWG_Stick_model.dwg file at XXXX:\Dataset\Autocad\3D_DWG_Stick_model.dwg

- Activate the drawing in the Project Manager and select the Structure menu
• Select the Member tool:

• In the command line select the Settings option to open up the Member settings dialog box

• Several settings and options can be chosen. Select HEA 280 as profile type. Confirm with OK.
In the command line select the Line option for member placement

Select the blue lines to add the profile type.

Confirm the selection with enter. The profile type is added to the selected lines.
Remark: Visual representation depends on the selected visual style. If the profiles aren’t visible in the project check the visual settings in the Shape options.

- Stay in the command after adding the first profiles and complete the structure with the other profile definitions:
  - Blue = HEA280
  - Red = HEA300
  - Green = HEA100
Members can be altered after placement. Select or multi-select the members that need to be changed and activate the right mouse menu. Use Edit Structure to re-open the Member Settings.
At this stage of the project the main focus lays in the positioning of the members and their location in the structure. In this project no machining will be applied to the structural members because we will do this in the Advance Steel environment.

Note: If necessary we can apply machining already in Plant 3D. These tools can be found under the Cutting panel and allows basic manipulation of the structural members like lengthen, cutback, miter cutback ...
In some cases the positions of stairs, railings and ladders are also added in a very early phase of the project. If needed, these kind of elements can also be added to the steel structure.

This concludes the first part of the preliminary design of the steel structure. Important at this point in the project is to have an understanding of the positions of the structural members in the project. Because this is an early stage in the project we still need to analyze the structure and afterwards optimize the steel members.

**Step 2: Export of the steel structure**

A new file format for Steel exchange is available in Plant 3D: Advance Steel XML export. The export will create a file containing all the information of the Steel Structure in Plant 3D and will be used to automatically create the same structure in Advance Steel.

- Activate the export command. A dialog-box appears. Give a file name and select all the structural members in the project. Use export to create the file.
A SMLX file is created in the chosen location containing all the information of the steel structure created in Plant 3D.

Remark: SDNF as an exchange format is still available. Use the SDNF EXPORT command in the command line to execute a SDNF export.

2. Import the Steel Structure from Plant3D into Advance Steel

Continue with the SMLX file exported from Plant 3D. Goal is to re-use all the information of the early design in Plant 3D in Advance Steel

Remark: quality of the exchange file depends completely on how it was created in the Plant 3D project. Rework might be necessary after import if structural members are not correctly positioned.

**Step 1: Import of the steel structure**

- Open Project: XXXX:\Dataset\Advance_Steel\ MBS_Start.dwg
- Select the Export & Import Ribbon. This will display a number of Import and Export options in Advance Steel. For this example we will use the Advance Import option.

- In the dialog-box go to the XXXX\Dataset\Plant_3D\SMLX\ 01_Steel_Silo_Structure.smlx location and select the SMLX file. Use Open to load the Steel Structure into Advance Steel.
- The Plant 3D Steel Structure is rebuilt in Advance Steel.
- In the Home Tab activate the Project Browser

This will open up a dialog-box which contains all the profiles and profile descriptions used in the project.

The Project Browser can be used for several different tasks. Selecting for example all the HEA100 profiles by clicking the first profile and Shift clicking the last HEA100 definition will select all these profiles directly in the project.
- Next step is to change the Role of the profiles in Advance Steel. To access the properties of the profiles select the structural elements that need to be altered.
- Right Mouse Click to access the menu. Select Advance Properties to open up the properties of the selected profiles.

- Properties defined in Plant 3D, like the material, are present in the Advance Steel Structure.
- In this presentation we will not cover all the properties of Advance Steel. Main purpose now is to make a distinction between the Columns and the Beams in the project. This can be used exporting the information to Revit Structure or Robot Structural Analysis.
- In the dialog box select the naming field. Chose the pull down menu in the second part of the naming field beside Model Role and select column in the list.
- Close the dialog box.
• In the model browser the field with Model Role is changed, showing now column as a Model role for the selected elements.
• If not select the Refresh button to update the fields in the dialog box.
• Continue until all structural members have a specific role in the structure:
  o Beams
  o Columns
  o Wind Bracings

• Remark: If the Model Role field is not available, right click on one of the fields to open the Insert Column option and select the Model Role from the list of possibilities.
Step 2 : Create an SMLX export file out of Advance Steel

Save the Advance Steel Project with a new name. The file will be used as the startup drawing for the steel project. Next step is the creation of a Project Coordination Model in Revit and/or a Structural Analysis Project in Robot Structural Analysis. To send over the created Steel Structure and the updated properties we will have to create a new SMLX file out of Advance Steel containing these changes.

- Continue with the Project or open the file: XXXX:\Dataset\Advance Steel\MBS_Start_01.dwg
- Select the Export & Import Ribbon and chose Advance Export to create the SMLX file

Step 3 : Optional workflow with Revit Structure

In this case we will create a coordination model in Revit based on the SMLX export out of Advance Steel. As in Plant 3D and Advance Steel, we also find an integrated toolbar in Revit Structure.

- Open a new Revit project and use the Structural Template
- Go to the Add Inns Tab and select the Advance Steel Extension
This will open a dialog Box.

- Select the Advance Import and the desired country library

- Select the output file from Advance Steel in XXX\Dataset\Advance Steel\SMLX\01_MBS_Start_Advance_Steel.smlx and confirm with OK

- The file is imported showing the Top View on the structure.

- Use the 3D view button to show the model in a perspective view

- Select the Realistic representation style to change the display of the structural members
By defining the role of the members in Advance Steel, Revit detects the column and beam definitions in the project. This will result in the correct filtering of the members in the schedules. If we compare a structural member in Advance Steel with the same one in Revit Structure we’ll notice that the properties have been migrated correctly.
Step 4: Optional workflow with Revit Structure: create a coordination model

If Revit needs to be a part of the Project Workflow it will be necessary to organize the Revit model for that purpose. This means that information like a grid or level needs to be defined in the Revit project. Therefore it is important to decide at this stage which environment will be leading. And which solutions will be involved in the process. In this case we will use:

- Revit Structure: for project coordination
- Robot Structural Analysis: for analysis and structure optimization
- Advance Steel: for documentation and detailing

Remark: other workflows can be chosen and used depending on your needs.

Organization of the Revit model is out of the scope for this presentation. To continue we will use an already prepared Revit Project. What has been added to the model:

- Project parameters:
  - Grids
  - Levels
- Dimensions
- Annotation Tags
- Schedules
- Floors
- Foundations
- Analytical model
• Open the file: XXXX: Dataset\Revit Structure\ MBS_RST_Start.rvt

**Step 5: Steel Structure analysis and optimization in Robot Structural Analysis**

**Workflow 1**: Integrated exchange between Revit Structure and Robot Structural Analysis: with the File: MBS_RST_Start.rvt still open, we will exchange the Analytical model from Revit with Robot Structural Analysis. For this we can use an integrated workflow that can be obtained by installing the Structural Analysis Toolkit 2016 that can be found on Autodesk Exchange.

• In Revit go to the Analyze Tab and select at the end of the ribbon the Robot Structural Analysis menu and activate Robot Structural Analysis link.
This opens up following menu which give several options to import or export an Analytical model.

In this case we will use the direct integration in Robot which will open up Robot Structural Analysis on export of the analytical model. Use OK to confirm.

Remark: the direct integration only works if Robot Structural Analysis is installed on your machine. If not you can use the Send to intermediate file option which will allow you to create an exchange file.

- The complete analytical model is transferred to Robot and rebuild by the analytical definition.
- With this workflow there is no need to recreate the complete analytical model from scratch.

**Step 6 : Analysis and optimization of the Steel Structure**

In this class we will not focus on the way how to analyze and optimize the steel structure and how the Analytical model can be build and defined in Robot. The following steps are made using Robot:

- Clean up or adjust the analytical model if necessary
- Define Release and Boundary conditions
- Add loads and load combinations to the analytical model
- Make the analysis
- Interpret the results
- Optimization of the steel structure
  - Material
  - Profiles
- Optional: create structural connections
- Code check the structural connections in Robot

Remark: in the workflow between Robot and Advance Steel the code checking can be done both in Robot or in Advance Steel.

- Open file: XXXX\Dataset\Robot Structural Analysis\MBS Steel Structure_1.rtd. This file already contains results of the calculation and optimization.
- Next step is to update the Revit file and transfer the information back into the Revit project
- Check if both models, Revit and Robot are open.
- The update can be done in both environments
- In Robot: go to the add ins menu and select Integration => Autodesk Revit Structure

- This will display a similar dialog box as we had in Revit. Select the “Send model and results” option with a direct integration.
• Second option is to activate the Update option in Revit Structure. Reactivate the Robot Structural Analysis link under the Analyze menu.

• In the dialog box use the Update model and results option
• This will transfer back the updated model and the results of the analysis. Confirm with OK.
• Next you will be prompted to define and name the result package.
• Deactivate the Required reinforcement package.

• Confirm with OK

• A progress bar shows the progress of the update of the profile definitions and the transfer of the different results.
• After the transfer the structural members are adjusted. Also schedules and annotations are adjusted.
Remark: not all information concerning loads and load definitions can be transferred to Revit Structure. Some information is directly related to the Robot Analytical model and can't be transferred or handled in Revit.

- The results that were transferred from Robot can be used in Revit. To explore the results go to the Results manager.

- Here we can find an overview of all Results packages that have been made during the project.
- In this case only one package will be available.
- To explore the results select the package and use the Explore button. This will open up the Results for Analytical Model dialog box.

- Examples of results for structural members and surfaces.

This way Analytical results can be integrated and documented in the Project model. It can be used on an entire model or on a selection of members and surfaces depending on the need of the structural engineer. Most used is an iterative approach were parts of the model will be analyzed to get an
understanding of the model. Several types of Analytical models for different purposes can be created separately in a Revit Project.

**Step 7: Export and update of the Advance Steel model**

Next step is exporting back the modified and optimized steel structure to Advance Steel to add structural connections and create project documentation. The updated model and all information will be exported back as a new SMLX file.

- In Revit go to the Add Ins tab and select the Advance Steel Extension. Use export to create a new updated SMLX file.

- Re-open or go to the corresponding Advance Steel model. Go to the Export & import Tab and select Revit Synchronization.
• The synchronization dialog box appears. Use load to open the export file created in Revit.

![Synchronization dialog box](image)

• At the bottom of the dialog box expand the filter field to reveal all the options that can be used to analyze the file and its changes.

![Filter field expanded](image)

• Uncheck under Changes the appended and deleted fields and use Apply filter to refresh the list. Some elements or descriptions will be filtered out. Click the change field to group the type of change that has been applied to the model. Scroll to the bottom of the list.
• At the bottom we will detect 5 columns that have been changed. Click select them and check the status box. Use the Apply all actions button at the top of the dialog box to accept the changes.
If the section is not available in the project, a dialog box pops up asking to select the correct and corresponding profile out of the libraries of Advance Steel.

Remark: this depends on which profiles and profile types are present in the project and project template.

- Search and select the correct profile in the library and confirm with OK

- Repeat for the 4 beams just above the columns in the list. Apply all actions to change the definition in the model.

- The optimized and changed profile definitions have been changed in the Advance Steel project.
Note: if needed, extra information like plates, walls and slabs can be added to the project to clarify the situation or to be used as a reference. To do so, first deselect the filter options in the dialog box and reselect appended. Use apply filter to update the selection.

- Select both slabs and use Apply All actions to add them to the project
This workflow allows us to export the steel structure from Advance Steel to Revit Structure to create a project coordination model and use the bi-directional workflow between Revit and Robot to analyze and optimize the steel structure. Later the results and optimized steel structure can then be used to update the Revit model and all the information already created in the project coordination model. From that point a new SMLX file can be created to update the steel structure in Advance Steel.

**Step 8: Steel Structure analysis and optimization in Robot Structural Analysis**

**Workflow 2:** A new option in Robot is now available. Using the new Add in allows Export, Import or Synchronization with an Advance Steel project. This is also a SMLX based workflow with no need any more to first create a Revit file to communicate between Robot and Advance Steel.
First step of the workflow is similar to the one we used with Revit except that we now use a SMLX file to communicate with Robot.

Workflow is:

- Export the steel structure from Advance Steel to a SMLX file
- Import this file into Robot
- Analyze and optimize the steel structure
- Export the optimized steel structure back into Advance Steel
- Add Structural Connections
- Use the EC3 check to validate the Structural Connections.

A prepared Robot export file is already created
Continue with the Project or open the file: XXXX: \Dataset\Advance Steel\ MBS_Start_01.dwg
This file has been used to create the SMLX file that was exported to Robot
• The Structural analysis and Optimization has already been done similar as in the previous exercise.
• After the Analysis a new SLMX file needs to be created incorporating all the changes and results that have been made.
• This can be done if the plugin, which can be found at the Autodesk Appstore, is installed. The plugin is free for Autodesk subscribers.
To use the plugin: go to the Add-Ins menu in Robot and select Integration – Advance Steel.

This opens up the dialog box to make the exchange definition.

Several options can be chosen to export, import and even synchronize structural models with Advance Steel.

For the export options check Export with calculation results.

This will not add all calculation results into the SMLX file but it will transfer the internal forces in the nodes to this file.

Go to the Advance Steel project. Use Advanced Synchronization to activate the Import.
- Select the export file from Robot: XXXX\Dataset\Robot Structural Analysis\Advance_Steel\SMLX\ MBS_Start_01_export_RSA_results.smlx.
- The dialog box shows besides the optimized steel members another category: Nodes.
- This category contains the information about the calculated internal forces in the structure.

- In the dialog box check the status field at the top. This will mark all the lines in the list and use Apply All Actions to update the structure.
- Profiles are changed according the definition of the SMLX file. At the nodes little flags appear. This indicates that they now contain information about their Internal Forces.
- This will be used to design the structural connection and make the EC3 check.
• To access the information, double click the flag to open the dialog box containing the information about the Internal Forces.

• With all information present we can proceed adding the structural connections to the steel structure.
• In Advance Steel a large library of connections is already predefined. If not activated you can open the Connection Vault in the Home Tab.
• In this list you can find all kinds of types of connections that can be added.
• Creation of custom library definitions is an option allowing you to personalize the use of the connections and build your own set of connections.
• In this presentation we will not explain the use of the Connection Vault.
• Open exercise: XXX\Dataset\Advance Steel\RSA\MBS_Start_01_results_RSA.dwg
• Several connections are added on the Structure.
- To access the definition of the connection select the Bounding Box of the connection and use the Right Button Menu => Advanced Properties.

- The properties dialog box of the connection is displayed. Here we can define the design of the connection or use already defined compositions from the library.
- Next step is the EC3 check of the connection. This option can be found under the Joint Design properties.
• Select Join Design and change the Design module in EC3 code check. Apply Check under Design Options to make the Code check.
• If the connection is verified and approved we will receive notification that it is OK and Checked.

• If checking fails it will indicate why it failed and what caused the failure.

• In that case the connection needs to be redefined and optimized.
• If necessary a report can be created showing the results. Apply Report to generate it.
Once a structure has been designed and checked, fabrication drawings can be created directly from the steel structure.

An example of a drawing can be found in this project.

The drawing has been created using the predefined templates available in Advance Steel.

All drawings can be accessed through the Document Manager. Here we can keep track of all information that has been created in the project.

Open the Document Manager. Under Details select Drawing 5.dwg and activate the Preview.

This shows an example of a drawing created with Advance Steel using the Drawing templates.
• To Open the Drawing select the Open Drawing command on the Right hand side of the dialog box.
• This will open the Drawing as a separate file.
• Other information that can be created:
  o Engineering files
    ▪ Elevations
    ▪ Cuts
    ▪ Lay-outs
    ▪ ....
  o BOM
  o CNC files

Note: if changes occur in the Steel Structure, the document manager will indicate that files need to be updated. This applies also if we should use an updated SMLX file with a new situation in the project.

**Step 9 : Using Plant 3D drawings as a reference**

At this point in a project, coordination between the different disciplines is becoming more important. Several possibilities are available to integrate information from one discipline into another. In our case it would be helpful to see the trajectories of the piping and position of the equipment in the model and drawings. Because both Autodesk solutions work on top of Autocad we can use an xref to integrate the Plant 3D information into Advance Steel.

• In the same project activate the Xref manager.
• Load the Vessel and piping in the project. Use Attach and select following files to integrate in the project: `XXXX\Dataset\Plant_3D\Equipement\ SKID-EQUIPMENT.dwg` and `XXXX\Dataset\Plant_3D\Equipement\ SKID-PIPING.dwg`. 
- The elements can now be used to support design of the steel structure.

Note: The files added to the Steel Project can only be used as a reference in the project. Actions like Clash detections with the steel parts can’t be made in this environment.

**Step 10: Add the steel structure as a reference in Plant 3D**

The inverted workflow is also possible. Use xref to replace the Early designed steel structure in Plant 3D with the more detailed version of Advanced Steel.

- Open project: XXXX\Dataset\Plant_3D\MBS-Steel-Silo-Structure\  
- Select the Vessel drawing under Plant 3D drawings.  
- Activate the Xref manager and select: XXXX\Dataset\Advance Steel\Plant 3D\MBS_Start_01_results_xref.dwg

- Use following insertion parameters:
Because the 0,0,0 point was conserved and shared, the structure will appear directly beside the vessel.

Note: The level of detail that will be used in Plant 3D is determined by the settings used in the Native Advanced Steel file. If details like bolts shouldn’t appear in the Plant project, they have to be turned off in this file.
Note: Object enablers have to be installed to assure the representation of all elements in the Advanced Steel project model.

**Step 11: Coordination with Navisworks**

The previous exercises showed the built-in capabilities of referencing different project information created in different environments. This is a great help to have an understanding of the project. It can be used to help you in the design and to take decisions. Because the files are referenced we don’t have the ability to use clash detection between all these pieces of information. For this task we can use Navisworks to create clash checking between all information of the project and even use it to track the involved elements in their proper environment.

- Open a new Navisworks project.
- Append following files:
  - `XXXX\Dataset\Navisworks\Revit\Platform.nwc`
  - `XXXX\Dataset\Navisworks\Advance Steel\MBS_Start_01_Revision.dwg`
  - `XXXX\Dataset\Navisworks\Plant 3D\SKID-EQUIPMENT.dwg`
  - `XXXX\Dataset\Navisworks\Plant 3D\SKID-PIPING.dwg`

- This will add the concrete walls and floors out of Revit, the steel structure out of Advance Steel and the Equipment of Plant 3D.
- Activate the Clash Detective
- Create following clash definition and Run Test

- The clash detective detects several clashes in the project. The first clash is the one between the pipe and the wall. This means that the clash information is divided over a Revit file and a Plant 3D project.
• In this case the clash is straightforward and detectable but this isn’t always the case and often it’s hard to track the interference back into the Native file.
• For this purpose we can use the Switch Back function in Navisworks which allows tracking of interferences directly back into the Native files.
• Open a new empty Revit project.
• In the Add Ins select external tools and activate Navisworks Switchback
- Now Revit can allow Switchback of information with Navisworks.
- Return to the Navisworks project. In the view select the Wall and open the Right Mouse Menu.
- Select Switch Back in the list

- In Revit the file which contains the wall will be automatically opened. A 3D view is created showing the concerned element highlighted in the project.

- This avoids the need of searching in several Revit files to find the element that causes the clash.
- Open a Plant 3D session (or Autocad) and type NWLOAD in the command line. Enter to accept.
- Navisworks returns the Message “Navisworks Ready”

- Go back to the Navisworks file and select the Pipe causing the clash. Repeat the steps using the Right Mouse Button Menu and select Switchback.

- The file is opened in Autocad or Plant 3D showing the Pipe element that causes the clash.
To finish return to Navisworks and select Clash 2. This is a clash between an Advance Steel element and the floor in Revit.

Activate Switchback in Advance Steel using the NWLOAD command.
- Repeat previous steps to activate Switch Back

- The Steel column is traced back into Advance Steel and displayed on screen.
In the Advanced Steel project activate the Xref manager
Under the Attachment options select the Attach Coordination Model

This allows the insertion of a NWC file into the project.
Select following file to Attach: XXX\Dataset\Navisworks\Revit\ Platform.nwc and Open the file.
- The concrete floors and walls are referenced back into the Advanced Steel project.

Note: If you want to perform Collision detection you still need to do this in Navisworks. Advance Steel does not have the capability of clashing multiple different types of information.